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RF Loop through 
for an external device

HDMI Output

TV Scart 
for connection to the TV

Remote sensor

USB port
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EXITMENU 

RECORD

DF00

EPG

Remote control

1

2

3

4

5

6

15

18

19

12

20

21

22

7

8

9

10

11

13

14

16

17

23

24

26

25

1

2

3

STANDBY
(switch the STB on and standby)

INFO
(Press for current channel information)

PLAY

26

OK button
(Confirm a selection within a menu)

Numeric entry
(Enter numeric values and select the channel 
directly by entering it's number)

AUDIO
(Select audio mode and audio track) 

SUBTITLE (Set up the Subtitle) 
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BACK
(Switch to previous channel)

EPG
(Open up Electronic Program Guide Menu) 

RECORD
(Record the TV program)

Search backward/forward

FAV
(Open the Favorite list)

RED/GREEN/YELLOW/BLUE Buttons
(For interactive function/Submenu 
 function buttons)

PAUSE(Pause/Active timeshift function)

Previous/Next

STOP
(Stop program playback or recording)

TV/RADIO
(Switch between TV and Radio)

MUTE (Turn off/on the volume)

MEDIA
(Enter Record menu)

USB
(Enter the Video menu)

TIMER
(Enter Timer Setting menu)

Menu
(Open and close the menu screen)

EXIT (Exit from menu)

RES (Switch HDMI resolution)

Cursor
(used to navigate menu's items)

TTX (On/Off teletext)



TV

SYSTEM CONNECTION
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Aerial

There are many different types of TV and other equipment that you can connect to the BOX. In this 
manual you will see some of the most common ways to connect your equipment.

HDMI TV 
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Stereo Amplifier

NOTE: 1. Do not plug/unplug HDMI connector while the BOX power is on.
2. Power indicator will turn green when the BOX power on, and 
turn red when the BOX goes standby.



Welcome

If you use the STB for the first time, the "Welcome" menu appears.

Press cursor button to setup the "Region", "Language", 

"Display Mode", "Aspect Mode".

Highlight "OK" and press the "OK" button to start channel search.

GETTING STARTED

Installation

Highlight "Channel Scan", press the "OK" button to enter the 

Channel Scan menu. 

Press the cursor button to set Scan mode, Scan Band ,Channel No., 

Frequency, Bandwidth and Network Search.

Highlight "Search", press "OK" button to start channel scan manually. 
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Auto Scan

Channel Scan

LCN

Press the "MENU" button to enter main menu.

Press "UP" or "DOWN" button to highlight "Installation", press 

"RIGHT" button to enter the "Installation" menu.

Press "UP" or "DOWN" button to highlight the desired item and 

press "OK" button to enter the sub-menu .

Press "EXIT" button to exit.

Highlight the "Auto Scan", press "OK" button to enter the 

Auto Scan menu.

Press the cursor button to set "FTA Only" /" T2 Signal Only". 

Highlight "Search", press the "OK" button to start channel scan 

automatically.

This menu allows you to activate/disactivate the LCN function.
If  LCN (Logical Channel Number)Select function is activated,You can't change  the 
original number of TV channels by scanning .

"Installation" menu allows you to set up channel search and LCN 

option. 

3
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Welcome

OK

Region

Language

Display Mode

Aspect Mode

New Password

Confirm Password

Czech

English

1080i@50HZ

16:9 full-screen

----

----

Channel Scan

Signal Intensity
Signal Quality

100%
100%

Scan Mode
Scan Band
Channel No.
Frequency
Bandwidth
Network Search
Search

By Channel
UHF

CH37(666000KHz)
666000KHz

8MHz 
No

Auto Scan

FTA Only

T2 Signal Only

Search

No

No

Installation

Auto Scan
Channel Scan
LCN

"Auto Scan" menu allows you to set up automatic channel search.

"Channel Scan" menu allows you to set up manual channel search.



OPERATION

Channel List 
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Accessing the Electronic Program Guide (EPG)

Accessing the EPG of all channels: 

1 Press the "EPG" button to enter the EPG menu, and a 
preview of your current channel will be displayed in 
the top right corner of the screen.
Press "UP" or "DOWN" button to select the desired channel,
Press "LEFT" or "RIGHT" button to select the desired event,
Press "GREEN" button to timer the event.
Press "RED" button to show the "Time bar" menu, you can 
select the way showing time and move time by pressing 
"OK" button. 
Press the "OK" button to display the information about 
the selected event.
Press "EXIT" button to back to the previous menu.

3/19 01:30 02:00 02:30 03:00

The Recor
Auntie's War on Smut
This is CBeebies!

The ReCommons Questions
Proms on FOUR

01:39    4/4   

0010 BBC NEWS 24

EPG

0008
0009
0010
0011
0012

Interecon
BBC Parl
BBC NEWS
CBeebie
301

TimerTime

2

3

0010 BBC NEWS 24

NowLanguage

BBC News
02: 00~02:30
News

 
eng(1/1)

Cancel Next

Exit time bar.

Back to the current time.

Jumps time forward or backward every half an hour. 

Jumps time forward or backward every 2 hours.

Jumps time forward or backward every 24 hours. 

In "Time bar" menu:

4

3/19 01:30 02:00 02:30 03:00

The Recor
Auntie's War on Smut
This is CBeebies!

The ReCommons Questions
Proms on FOUR

01:39    4/4   

0010 BBC NEWS 24

EPG

0008
0009
0010
0011
0012

Interecon
BBC Parl
BBC NEWS
CBeebie
301
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You can access the Channel list by pressing "OK" button.
Press the cursor buttons to select the channel you want to view.  



Edit Channel menu 

EDIT CHANNEL

TV / Radio Channel list

In the Edit Channel menu, highlight "TV Channel List" or "Radio 
channel List", press "OK" button to enter TV channel list/Radio 
Channel list menu.
Press "UP" or "DOWN" button to highlight the desired channel, 
press the "OK" button, a preview of the channel will be displayed 
in the top right corner of the screen.

1

2

Use this menu to set up Favourite, lock, skip, move, sort, delete and 
rename for the selected TV/Radio channels.

Press "FAV" button, then press "OK" button to set the FAV channels.
Press "Red" button to activate "Lock" function, then press "OK" 
button, you will be asked to input the password then the selected 
Channel will be locked.
Press "Green" button to activate "Skip" function, press "OK" 
button to skip the desired channel.
Press "Yellow" button to activate "Move" function, highlight the
desired channel and press "OK" button to confirm. Press "UP" or 
"DOWN" button to select the new position and press "OK" 
button, the channel will be moved to the new position.
Press "Blue"button to enter Edit channel sub menu. 
Press "OK" button again to cancel the corresponding function.
Press "colour" buttons again to exit the corresponding function.
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Press the "MENU" button to enter main menu.

Press "UP" or "DOWN " button to highlight "Edit Channel", press 

"RIGHT" button to enter the Edit Channel menu.

Press "UP" or "DOWN" button to highlight the desired item and 

press "OK" button to enter the sub-menu .

Press "EXIT" button to exit.

Press "Exit" button to save and back to "Edit Channel" menu3

Basically, the operation of "Radio Channel List" is the same as "TV Channel List", 
but there is one point different: In "Radio Channel List" mode, there is no video 
information, so it will always display Radio's logo in the right side preview window.

NOTE:

Delete All

1

2 A warning window appears.
Select "Yes", press "OK" button to delete all channels.
Select "No", Press "OK" button to cancel deleting.

In the Edit Channel menu, highlight "Delete All", press "OK" 
button. You are asked to input a password.

TV Channel List
Radio Channel List
Delete All

Edit Channel

TV Channel List

All TV

FAV Lock Skip Move Edit

0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 Telecinco
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

DVBT

Telecinco

498167KHZ/8K/64QAM

PID:203/303/203

GI:1/32 FEC:3/4

DVBT

Telecinco

498167KHZ//

PID:203/303/203

GI:   FEC:1/2

Edit Channel

All TV

Sort Rename Delete

0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 Telecinco
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

Warning! Do you really want to 
delete all channels?

NoYes



System setup menu 

Language 

This menu allows you to set Language of system, Audio, Subtitle and
Teletext and to set subtitle function.

SYSTEM SETUP

TV System

This menu allows you to set Video Resolution, Aspect Mode, 
Video Out and Digital Audio Out.

Local Time Setting

This menu allows you to set the region and the local time.

Region: 

GMT Usage:  

GMT Offset: 

 

Summer Time:

Date/Time:

Use this menu to change the region.

Use this menu to open the usage of GMT by 

Region/User Define. 

Also to close the usage of GMT.

The GMT offset range is "-11:30 ~ +12:00", 

increasing every half hour progressively.

(Only valid in "User Define" mode for GMT 

Usage.)

On/Off 

Press numeric button to set the date/time.

(Only valid in "Off" mode for GMT Usage.)

Video Resolution:

Aspect Mode: 

Video Out:

Digital Audio Out: 
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Press the "MENU" button to enter the main menu.
Press "UP" or "DOWN" button to highlight "System Setup", 
press "RIGHT" button to enter the System Setup menu.
Press "UP" or "DOWN" button to highlight the desired 
item and press "OK" button to enter the sub-menu.
Press "EXIT" button to exit.

Set up Various video resolutions.

4:3PS/4:3LB/16:9PB/16:9PS/4:3 full-screen/

16:9 full-screen

CVBS/RGB

BS Out/LPCM Out

Many aspects of your STB can be set to reflect your circumstances 
and preference. 

Subtitle: Off/Normal/Hard of Hearing

System Setup

Language
TV System
Local Time Setting
Timer Setting
Parental Lock
OSD Setting
Favorite
Audio Description Setting 
Other

Language

Language

First Audio

Second Audio

Subtitle Language 

Teletext 

Subtitle

Mp4 Subtitle CodePage

English 

Czech

Czech

Czech

Czech

Off

Windows-1250

Video Resolution

Aspect Mode

Video Out

Digital Audio Out

720p@50HZ

4:3 full-screen

CVBS

LPCM Out

TV System

Local Time Setting 

Region

GMT Usage

GMT Offset

Summer Time

Date

Time

United Kingdom

By Region

GMT+ 00:00

On

12/07/2016

01:51

Reykjavik,Casablanca,Lisbon,Dublin,London

Mp4 Subtitle CodePage: Windows-1250/ISO8859



OSD Setting

This menu allows you to set the time of OSD Timeout and OSD 
Transparency .

This menu allows you to rename the favorite group.

OSD Timeout:

OSD Transparency:  

1-10

Off/10%/20%/30%/40%.

SYSTEM SETUP

Parental Lock

In "System Setup" menu, highlight "parental Lock" and press "OK" 
button, you are asked to input a password.

After inputting the correct password by pressing numeric buttons, 
the parental lock menu appears.

1

2

Menu Lock:

Rating Lock:  

New Password:  

Confirm Password:  
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To lock the Edit channel/ Installation menu. 

You can set menu lock to on/off.

Off/AGE 4~AGE 18.

To change the password.

To confirm the new password.

This menu allows you to lock the menu and the channels, set Rating 
Lock and change the Password.

Favorite

In "System Setup" menu, highlight "Favorite", press "OK" button to 
enter Favorite menu.
Select the favourite group you want to change, press "OK" button 
to open the mock keypad. Input letter and numeric one by one by 
pressing the cursor buttons and press "OK" button to select, after 
finished input, press "Blue" button, you changed Favorite group 
name successfully.
Press "EXIT" button to quit the group rename menu.
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Timer Setting

This menu allows you to set the program timer. You can set 8 timers.

Timer Mode:

Timer Service:

Wakeup Channel:

Wakeup Date:

On Time:

Duration: 

Off/Once/Daily/Weekly/Monthly

Channel/Record

Set a desired channel as the wakeup channel.

Set Wakeup Date by pressing numeric button.

Set On Time by pressing numeric button.

Set Duration by pressing numeric button.
Save Cancel

                                                      14:55                                                      12-07-2016

Timer Mode

Timer Service

Wakeup Channel

Wakeup Date

On Time 

Duration

Off

Channel

BBC FOUR

12/07/2016

16:00

02:00 

Parental Lock

Menu Lock

Rating Lock

New Password

Confirm Password

Off

Off

----

----

OSD Setting

OSD Timeout

OSD Transparency

5

Off

Favorite

1

2

3

4

5

6

7

8 

Favorite 1

Favorite 2

Favorite 3

Favorite 4

Favorite 5

Favorite 6

Favorite 7

Favorite 8

A
G
M
S
Y
4
SP

B C D E F
K LH JI

N
T
Z
5

O
U
0
6
?

P
V
1
7
<-

Q
W
2
8
OK

R
X
3
9

Rename

Favorite 1 

DEL OKCAPS



SYSTEM SETUP

Audio Description Setting

On/Off

On/Off

-3~3

AD Service: 

Use AD as default:

AD Volume Offset:

This menu allows you to set up Audio Description Setting.
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Other

Antenna Power:

Channel Play Type:

Auto Standby:

Loopthrough In Standby:

This menu allows you to set Antenna Power, Channel Play Type, 
Auto Standby and Loopthrough In Standby.

On (STB will provide 5V power to antenna)

Off (STB will not provide 5V power to antenna)

All/Free/Scrambled

30 Min/1 Hour/2 Hours/3 Hours/Off   

On/Off

Audio Description Setting

AD Service 

Use AD as default 

AD Volume Offset

Off

Off 

0

Other

Antenna Power

Channel Play Type  

Auto Standby

Loopthrough In Standby

Off 

All  

3 Hours

Off

                 TOOLS

Information 

In "Tools" menu, highlight "Information", press "OK" button to open 
information window.

Press "EXIT" button to exit "Information" menu.

1

2

Tools main menu 

4

1

2

3

Press the "MENU" button to enter main menu.

Press "UP" or "DOWN" button to highlight "Tools", press "RIGHT" 

button to enter the Tools menu.

Press "UP" or "DOWN" button to highlight the desired item and 

press "OK" button to enter the sub-menu.

Press "EXIT" button to exit.

You will find here important information about the hardware and 
embedded software.

Tools

Information

Factory Setting

Software upgrade by USB

Remove USB device safely

Information

Receiver

Hardware

Software

Build Date

EVOLVEO Gamma T2

EVOLVEO Gamma T2

H265 V1.2.7

May 19 2017
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Factory Setting

This menu allows you to re-set the STB back to the factory settings, 
clear all existed channels.

In the "Tools" menu, highlight "Factory Setting", press "OK" button. 1

2 A confirmation window is displayed.
Select "Yes" to return back to factory settings and clear all channels.
Select "No" to cancel back to factory settings.
Press "EXIT" button to exit "Factory Setting" menu.3

Software Upgrade

Press "EXIT" button to exit "Upgrade by USB" menu.

In the "Tools" menu, highlight  
"Upgrade by USB", press "OK" button, Software Upgrade menu 
is shown.

1

2 Press cursor button to select the desired item, then highlight 
"Start" and press "OK" button to start upgrade.

3

This menu allows you to upgrade software version by USB.

Factory Setting

"This operation will load default and erase all
the channels that user added, continue?"

Yes No

Software upgrade by USB

Upgrade Mode

Upgrade File

Start

AllCode

xxx

0%

Tools

Remove USB device safely

In "Tools" menu, highlight "Remove USB device safely". 

Press "OK" button to confirm. Then a window is displayed.

Select "OK" button to remove the USB device.

Select "Cancel" button to cancel the operation.

This menu allows you to remove the external USB device safely.

1

2

Disk Remove

Remove USB Disk A-3 GB

OK Cancel



Media Player main menu

Media Player
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Press the "MENU" button to enter main menu.

Press "UP"or "DOWN" button to highlight "Media Player", press 

"RIGHT" button to enter the Media Player menu.

Press "UP" or "DOWN" button to highlight the desired item 

and press "OK" button to enter the sub-menu.

Press "EXIT" button to exit.

Ensure to insert an external Mass Storage Device on the USB port.

Media Playback

Media Player

Record

Video

Music

Image

HDD Information

DVR Setting

Music Image Video Record

USB1

1.
2.
3.
4.
5.

/..
MP3

MP3

MP3

MP3

MP3

840.mp3
I swear.mp3
Why.mp3
Lonely.mp3
Because.mp3

/xx/xxx/Music

Play List

Switch1 Sort

FAV
2 Repeat  

FAV All
INFO

Edit

ExitEXIT

840.mp3
3319KB
00:03:32

00:03:3200:00:40

Music:

Image:    

 Press  "RED" button to show Play List. 
 Move the highlight to the file which you want to add to play list, then press 
"Green" button to add. It will mark a favorite icon on the file.
Press "Yellow" button to add all file of current directory to play list. Press again to 
delete all file of current directory from the play list.
Press "Blue" button to enter to edit sub-menu.
Press to switch TAB between Music/Image/Video/Record.
Press "2" button to open the sort window. 
You can sort by Name/Time/Size/Favorite.
Press "INFO" button to set repeat mode. The option is Repeat Folder/ 
Random Folder/Repeat One.
Return to the upper directory.

Press "Red" button to show play list.
Move the highlight to the file which you want to add to play list, then press 
"Green" button to add. It will mark a favorite icon on the file.
Press "Yellow" button to add all file of current directory to play list. Press again to 
delete all file of current directory from the play list. 
Press "Blue" button to enter to edit sub-menu. 
Press to switch TAB between Music/Image/Video/Record.
Press "2" button to open the sort window. 
You can sort by Name/Time/Size/Favorite.
Press "INFO" button to open image setup
Press "3" button to view image in multi view mode
Return to the upper directory.

"RED" button: 
"GREEN" button:
 
"YELLOW" button: 

"BLUE" button:
"1" button: 
"2" button:
 
"INFO" button: 

"EXIT" button:

"RED" button: 
"GREEN" button:
 
"YELLOW" button: 

"BLUE" button:  
"1" button: 
"2" button: 

"INFO" button: 
"3" button: 
"EXIT" button:

3

In "Media player" menu, highlight "Record", "Video", "Music" or 
"Image".
Press "OK" button to enter Media Playback menu.
Press "UP" or "DOWN" button to select a desired media file, 
and press "OK" button to play the files. 
Press "EXIT" button to exit.

1

2

This function allows you to play the media files from the USB HDD.     

4



This menu allows you to set the DVR Settings.

DVR Setting
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Media Player

HDD Information

Record

Press to Rename the selected recording file.
Press to Lock the selected recording file.(The password is necessary for the 
operation),
Press again to unlock the recording file.
Press to delete the selected recording file.
Press to switch TAB between Music/Image/Video/Record.
Return to the upper directory.

Video:

"RED" button: 
"GREEN" button:
 

"YELLOW" button:
"1" button: 
"EXIT" button:

Press to enter to edit sub-menu for the selected file.
Press to switch TAB between Music/Image/Video/Record.
Press to sort the files of the current directory by Name/Time/Size.
Press to set repeat mode (Repeat Folder/Repeat One).
Return to the upper directory.

"BLUE" button: 
"1" button:
"2" button:
 "INFO" button: 
"EXIT" button:

In "Media Player" menu, highlight "DVR Setting", 

press "OK" button to enter "DVR Setting" menu.

Press "UP" or "DOWN" button to highlight the desired 

item and press "LEFT" or "RIGHT" button to change the setting.

Press "EXIT" button to exit.

1

2

3

Timeshift:

Jump:  

After Recording: 

Pause/Off/Auto

30 sec/1 min/5 min/10 min/15 min/20 min/30 min

Watch TV/Go to Standby-mode

Format DVR Set

HDD Information

Volume:
Total Size:
Free Size:
Rec Size:
TMS Size:
File System:

xxxx
xxxx bytes
xxxx bytes
xxxx bytes
xxxx bytes

NTFS

USB Disk A: xxxG bytes

Format

Disk Mode FAT

OK Cancel

DVR Setting

Timeshift

Jump

After Recording

Pause

30sec

Go to Standby-mode

DVR Set

DVR Type REC & TMS

OK Cancel

DVR Set                 REC&TMS/Record/Timeshift

Press BLUE button to open DVR Set menu. 
Press "LEFT" or "RIGHT" button to change DVR Type.
Press "OK" button to format. Press "Cancel" button to cancel.

Press YELLOW button to open Format menu.
Press "LEFT" or "RIGHT" button to change Disk Mode.
Press "OK" button to format. Press "Cancel" button to cancel.

Format               FAT/NTFS

In "Media Player" menu, highlight "HDD Information", 

press "OK" button to open HDD information window.

Press "EXIT" button to exit.

This menu can display some parameters of Removable HDD.

1

2



Press "PAUSE" button to pause the playback.

Press "FORWARD" button to fast forward the playback.

Press "BACKWARD" button to rewind the playback.

Press "STOP" button to stop TimeShift playback and return to Live programme.

During the playback, it is possible to perform the following actions :

Instant record:

Press "RECORD" button again can input duration.

Press "STOP" button to stop recording, then a confirmation window appears. 

Select "Yes" to stop recording. Select "No" to continue recording.

In full screen mode, press "RECORD" button to record the current programme instantaneously.
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Initiate:

Time Shift can be done in full screen mode by pressing the 
"PAUSE" button.

Press "RIGHT" or "LEFT" button to select the time you want to start. 

Press "OK" button to start timeshift playback.

Playback

Timer record

You can enter timer setting menu to set a timer record by EPG or System set up option. 

TIMESHIFT/RECORD

Timeshift

Record

Plugging an external Mass Storage Device on the USB port gives you access to Time Shift/Record 
a broadcast programme.

Pause a broadcast programme and continue watching it later (Time Shift )
Record a broadcast programme.
When the space available on the Mass Storage Device runs out, recording operation of 
broadcast will stop.

Please use USB 2.0 disk when recording or timeshift.
For timeshift and recording feature, you need take bigger size USB driver or HDD (>2GB).

NOTE:

M6 17/11 01:36

Play    00:02:37 00:05:37

412412412 188 188

100%

TS

This product allows you to record two channels from different frequency 
at the same time.

NOTE:



In some region, the digital terrestrial signal may be weak. So you'd better use the antenna in 
which the booster was built, for watching the weak signal channels.

TROUBLESHOOTING

Problem

Standby light not lit

No signal found

Channel search is not 
working.

Coded channel alert.

No response to remote 
control

No password is listed 
anywhere.

There is no sound.

After moving your player to 
another room, you've found 
that you no longer receive 
a digital signal.

Possible cause What to do

Mains lead unplugged 

1. The antenna is not properly 
     aligned.
2. The signal is too weak.

The channel is encoded.

The receiver has no power cord in 
the socket. 
The driver is not properly
pointing. 
The front of the player is 
shaded. 
The batteries are exhausted.

The selected channel has a signal 
but no sound.

By moving, the signal strength 
received by the player may be 
reduced.

Connect the main power cable.

1. Adjust the direction of the 
    antenna.
2. Get a stronger antenna or 
    antenna amplifier.

Be sure to set the antenna
in the player's main menu is correct.

Select alternative channel

Plug the main power cord into the 
socket. 
Point the driver to the front of the 
player. 
Loosen the space in front of the 
front of the player. 
Replace the batteries.

The default password is always 
0000.

Press the Audio button to make 
sure the selected channel has 
sound.

The antenna cable must ideally 
have the same length as the 
previous room, or use an amplifier
 signal or use a signal amplifier

1 English14



TUNER & CHANNEL RF INPUT CONNECTOR x1
(IEC-TYPE, IEC169-2, FEMALE)

RF OUTPUT CONNECTOR x1
(IEC-TYPE, IEC169-2, MALE (LOOPTHROUGH))

FREQUENCY RANGE:
174MHz~230MHz(VHF)
470MHz ~862MHz (UHF)

SIGNAL LEVEL: 
-15 ~ -80 dbm

DECODER

Video decoder

Audio decoder

VIDEO FORMATS                    

MODULATION

                       

VIDEO OUTPUT                      

INPUT RATE                                                 MAX. 48Mbit/s

                    4:3/,16:9 SWITCHABLE

HDMI, CVBS,RGB

QPSK,16QAM,64QAM, 256QAM

CONNECTION

TUNER

POWER SUPPLY
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MPEG-2 MP@HL, AVC/H.264 HP @L4.1
MPEG-4 ASP SUPPORTED,HEVC/H.265 MP@L4.1

MPEG-1 Layer 1,2/PCM/HE-AAC V1.0
ICE958 SPDIF/Dolby D+ and Dolby D

SPECIFICATIONS

HDMI

DATA PORT

SCART

SPDIF

INPUT VOLTAGE 

ANTENNA INPUTx1, RF OUTPUT x1 

HDMI OUTPUT x1

USB slot x2

TV OUTPUT x1

COAXIAL OUTPUT x1

12V      1A

Hereby, the company Abacus Electric, s.r.o. declares that the EVOLVEO Gamma T2 is in compliance
with the requirements of the standards and regulations, relevant for the given type of device.

DECLARATION OF CONFORMITY

Find the complete text of Declaration of Conformity at ftp://ftp.evolveo.com/ce

Copyright © Abacus Electric, s.r.o.
www.evolveo.com 
www.facebook.com/EvolveoEU

All rights reserved. 
Design and specification may be changed without prior notice.

Dovozce / Dovozca / Importer / Importőr
Abacus Electric, s.r.o.
Planá 2, 370 01, Czech Republic

Výrobce / Výrobca / Manufacturer / Gyártó
Naxya Limited
No.5, 17/F, Strand 50, 50 Bonham Strand, 
Sheung Wan, Hong Kong
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